
Teaching Notes

These teaching notes were originally developed for computer classes at Durbar High School in
Kathmandu, Nepal, using Windows 95 and Office 95. Since then they have been rewritten for
Office 97 and extended. Lesson plans have also been developed for some topics to help Cambodian
teachers prepare their lessons.

We wrote the notes for our own use so that we have a clear picture of what we will be teaching.
They are not really students’ notes, though we do encourage students to read them on the computer
after lessons and to practise the exercises again.

We offer them freely for use by non-profit organisations in the spirit of co-operation. The copyright
notice must be left intact on all the pages and modified versions of the documents must not be
redistributed.

We realise that they are not perfect, so if you find any mistakes or think certain sections could be
clearer then we would appreciate your feedback via e-mail to andy_price@hotmail.com

Happy teaching!

Andy & Ming
9th October 2002
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Notes (6) - More Windows Features

There are many features which are common across all Windows programs. This is a big
advantage, for when you have learnt one program you will find it easy to use another.

title bar
(note: open Notepad for practice)

All windows have a title bar at the top.  At the left is an icon representing the program or
document.  Try double-clicking on this and it closes the window.

Next to this icon is the name of the document in use (if the document has not been saved for the
first time it will show as “untitled” in Paint and Notepad or “Document + a number” in
Microsoft Word) and the name of the program.

To the right of the title bar are the minimise, maximise/restore and close buttons.  Try double-
clicking on the title bar and it has the same effect as clicking the maximise/restore button.

The title bar is blue if the window is active, or grey if it is not.

[Note: You can only work in an active window.  To make it active, click anywhere within the
window.  If a window is minimised or hidden, then click on its minimised icon on the taskbar.]

menu bar
(note: see the next page for screen shots)

The menu bar has a number of common “drop down” menus, almost always including File,
Edit and Help.  Other menus will be present according to the application.  Clicking on a menu
item will drop down a list of options, some of which may include sub-menus – these have a
small arrow head pointing to the right.  Selecting an option will initiate an action (e.g. save a
document), affect the operation of the program in some way (e.g. show or hide the ruler) or
modify the work in progress (e.g. add a border to a table).

Practice:  Click on File on the menu bar in Notepad and see what is on the drop down menu.
Do the same for the Edit menu.  Open Paint and select View, then tool box and observe what
happen. A tick shows that the option is selected.  Deselect and reselect both the tool box and
colour box.

Menus are usually activated using the mouse, but they can also be operated from the keyboard.
One letter of each menu item will be underlined.  To activate it, hold down the Alt key and
press the underlined letter.  For example, to open the File menu, press Alt + F.  Move up and
down the opened menu using the arrow keys and press enter when the desired option is
highlighted, or press the underlined letter.  The action will be initiated and the menu will then
close

Some items on the drop down menus may not be available and these will be “greyed out”.  For
example, if you have not selected any text, the copy option on the Edit menu will be inactive.

Practice:  In Paint, press Alt + V to bring up the menu under View.  Move down to the colour
box using the down arrow key and press enter.  Observe what happen.  Try also pressing Ctrl +
T and observe what happen to the tool box.  Finally, close Paint using the keyboard only.
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status bar

tool tip

vertical scroll
bar

horizontal scroll bar

In the View menu, notice the underlined letters: T on Tool Box, C on Color Box, S on Status Bar.
Also next to Tool Box is Ctrl +T and Ctrl + L for Color Box.  Tool Box, Color Box and Status Bar
are ticked.
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toolbar
Not all programs have a toolbar, but most do.  Some have several specialised toolbars which
can be made visible or hidden at will; others have toolbars which appear depending on what
you are doing at the time (e.g. a text formatting toolbar might appear when you use the text tool
in Paint).

All toolbars contain buttons (or icons) which are clicked with the mouse to select them; once
selected they appear to be pressed in like a real button.  Sometimes buttons may be in
interlinked groups and selecting any one of them automatically deselects all the others (e.g. text
alignment in Word – align left, centre, align right or justify).

Toolbars often duplicate functions found on menus.  They have the advantage of speed and ease
of use.  Sometimes it is not obvious what a particular button does just from looking at the
picture.  Place the cursor over the button but do not click; a small yellow box appears telling
you either the name of the tool or stating its purpose.  This is called a tool tip. Alternatively, a
short description of the button’s function may appearing the status bar at the bottom of the
program window (see below).

Note that some items on the toolbar may not be available and these will be “greyed out”.

Practice: Look at the Word window and notice that there are two toolbars below the menu bar.
Move the cursor slowly from one icon to another and read the tool tips which pop up.

status bar
At the bottom of many programs is a narrow bar which displays information about the current
status of the program, document or selected item e.g. information about the cursor position is
shown in Paint.

Practise: Open Paint and move the cursor around on the canvas.  Note what happens on the
right of the status bar – co-ordinates show the position of the cursor relative to the top left hand
corner.  Click on the rectangle tool and notice what happens on the left of the status bar – gives
the description of the tool function.

scroll bar
Documents are often larger in area than the window they are being viewed in, or may even be
larger than the monitor screen!  You need a way of moving the document around under the
window so that all of it can be seen.  This is the function of the scroll bars, which appear at the
bottom and right side of the document window.  In some programs they appear only when
required like in Notepad, in others they are always visible like in Word, even if the document is
smaller than the window and they are therefore inactive.

Scroll bars generally consist of a grey bar with arrow heads at both ends and a small movable
rectangle in the middle.  To move the document in the window you can click on the arrows,
press down on the arrows, drag the rectangle or click on the bar between the rectangle and the
arrows.

Practice: Try all of these methods of scrolling on this document.  See how they differ in their
effects.
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help
It is essential that you learn how to use the Help function as this is a valuable source of
information about how to use the features of a program.  There are three ways to activate it:

Click on Help on the menu bar and then choose from the options listed – they vary, but usually
you will see “Contents”, “Topics” or “Index”.

Click on the Help icon on the toolbar and choose from the options as above.

Press the function key F1 at any time that you need help with what you are doing. This is called
“context sensitive help” and is supposed to offer help which is relevant to the current situation.
In some programs pressing F1 simply opens the normal help screen.

Practice:

Open Paint, click on Help and select Help Topics.

• In the Paint Help window, select the Contents tab if it is not already selected.  A list of
topics is displayed.  Choose “Erasing” and the list expands to show more detailed choices
with a question mark icon to the left.  Click on for an example “Erase a large area” and the
relevant information is displayed in a box..

• In the Paint Help window, select the Index tab if it is not already selected, enter ‘curve’ in
the box provided - notice how the list below changes as you are keying in and the selection
is made for you even before you finish keying the word ‘curve’ in full.  Select (for example)
‘To draw a curve’ and click ‘Display’.  The relevant information is displayed in a box.
Alternatively you can scroll down the index until you find the topic you are interested in
and then double click on it.

• In the Paint Help window, select the Find tab if it is not already selected, and then enter the
search term “paint” in the box provided.  A list of topic areas, for example paint, Paint,
painting, is displayed in the box below.  Select one of them and the relevant help topics are
displayed in the box below that.  Select the topics you want and then click the display
button.  The relevant information is displayed in a box.

Which of the above methods you choose depends on how much you already know and what
you are trying to find out.  If you want general or background information on a topic then select
from the Contents tab.  If you want information on a specific topic that you can name then use
the Index tab.  If you don’t know exactly what you are looking for then use the Find tab and
guess a word to enter the search box.

Practice:  Open Paint and find out how to use the Polygon tool.  Try it out to make sure you
understood the Help files correctly.

To create irregular polygons – closed shapes made up of straight lines which are not
symmetrical.  First choose a thick line (by clicking on the straight line tool and choosing a
thickness) then click the Polygon tool and draw a straight line on the canvas.  Release the
mouse button, move the cursor a little and then click the left button again.  A second line is
drawn between the current position of the cursor and the end of the first line.  Move the cursor
again, click again to draw a third line. Continue drawing lines until you finally meet up with the
start of the original line, closing up the shape.
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The Contents Page with a topic selected Information on the topic

Index page with the topic typed in Find page with the topic typed in
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dialog boxes
You are often required to make selections when working with Windows programs.  The most
common way to do this is by making selections in a dialog box using controls such as radio
button, check box and list box and spin box.  You may come across these individually or you
may see all of them at the same time in a complicated dialog box e.g. in Word.  Although they
are all used for making choices their usage differs.

Radio buttons are used to select one option out of several.  When you click on the option you
require, a black circle appears and the others are automatically deselected.  For example, in the
Paint program if you click on  Image on the menu bar, then Attributes, you will see that you can
choose between inches, centimetres or pels, and between black and white or colour.

A check box is used to make multiple selections.  When you click on one option a tick appears,
but it does not affect the other items nearby.  For example, in Word if you click on Format on
the menu bar, then Font and Font again in the dialog box.  Under Effects you can select Small
Caps, Hidden, etc.

If you have a large number of options to select from, it would take up a lot of space to have
dozens of radio buttons in a dialog box.  Instead, a list box can be used and this has a
downward pointing arrowhead to the right of the box.  When you click on the arrowhead, a list
of alternatives drops down.  If the list is long enough, scroll bars appear too, to enable to
navigate through the list.  When you see the option you want simply click on it to select it.  For
example, in Word if you click on Format on the menu bar, then Borders and Shading, and
Borders again, you will see an option labelled Color which illustrates the above.

The fourth input device is the scroll box.  This is similar to the list box except that there is no
arrowhead to click – the box is of fixed size and you simply scroll through the options and click
on the one you want.  For example, in Word if you click on Format on the menu bar, then
Borders and Shading, and Borders again, you will see an option labelled Style which illustrates
the above.

check
boxes

Radio
Buttons
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A simplified version of the scroll box is called spin box which is used to select numerical
values in many dialog boxes.  This consists of  a small box with two scroll arrows to the right.
Clicking on the arrows changes the value displayed in the box.  For example, in Word if you
click on Format on the menu bar, then Paragraph. Click on Indents and Spacing in the dialog
box.  You will see an option labelled Indentation which illustrates the above.

list box

scroll box

spin boxes
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keyboard shortcuts
If you are typing a large amount of text it is more convenient to issue commands from the
keyboard instead of having to move your hand to the mouse.  Windows and Windows programs
incorporate a large number of “keyboard shortcuts” to facilitate this.  Many of them are
common to all Windows programs and it is worth learning and using them.

To use a keyboard shortcuts you usually hold down one key and then press another.  Very
occasionally you have to press three keys simultaneously, but this is not easy and is therefore
uncommon. Below are the most commonly used:

Ctrl + A Selects all the whole document ready for further action (e.g. copy to 
clipboard). This does not work in Notepad

Ctrl + X Cuts the selected text from the document and places it on the clipboard

Ctrl + C Copies the selected text to the clipboard but leaves the original in place

Ctrl + V Pastes the contents of the clipboard into the active document

Ctrl + N Opens a new document.  This does not work in Notepad

Ctrl + O Opens an existing document. This does not work in Notepad

Ctrl + S Saves the active document. This does not work in Notepad

Ctrl + P Prints the active document. This does not work in Notepad

Ctrl + Z Undo

F1 Brings up the Help Topics window

F2 To rename, e.g. a document name, a folder name, etc.  Needs to first highlight
the object

F5 Refreshes the contents of a window e.g. the Network because of changes
which are not immediately shown in the window.  In Notepad it brings up the
date/time instead

Alt + Tab Switch from one window to another

Ctrl + Alt +Del Opens up the Close Program dialog so that “frozen” programs can be shut
down.  Not to be used unless you are having problems closing applications

Practice:  Open Notepad, type a few lines and practise using Ctrl C (copy), Ctrl X (cut), Ctrl V
(paste), Ctrl Z (undo).  Open Paint, draw a picture and practise using Ctrl S (save) and Ctrl +N
(new).  Using Alt +Tab practise moving between windows.


